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 EXCEL environment 
This environment is similar to other applications: Excel, PowerPoint, Outlook. 

 

 A grid consists of a total of 16 384 columns with alphabetical headers, the last column 

bearing the XFD header. 

 Each row also has a header. Row headers are numbers ranging from 1 to 1 048 576. 

 This represents 1,500% more lines and 6,300% more columns than in previous versions. 

 RELATIVE OR ABSOLUTE ADDRESSES 

 

 Whose formula adjusts during a copy. 

 

 Fixed address, it does not change during a copy. 

 

 The cell chosen to perform the formula remains the same. Excel returns to the same column 
and line when copying. 

Example of RELATIVE ADDRESSES: 
 

A B C D 

1 Amount Description Price Total 

2 20 Computer 2000 =A2*C2 

3 25 DVD 275 =A3*C3 

4 15 iPad 950 =A4*C4 
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Example of ABSOLUTES ADDRESSES: 
 

A B C D 

1 Description Price Gst Qst 

2   5% 9,975% 

3 Computer 2000 B3'$C$2 =B3*$D$2 

4 DVD 275 B4-$C$2 =B4*$D$2 

5 iPad 950 B5-$C$2 =B5*$D$2 

Example of RELATIVES AND ABSOLUTES ADDRESSES: 

 A B C D E 

1  
Billing Date DEADLINE 1 DEADLINE 2 DEADLINE 3 DEADLINE 4 

2   30 60 90 360 

3 
24 Nov 2019 =$A3+B$2 =$A3+C$2 =$A3+D$2 =$A3+E$2 

4 
23 Dec 2019 =$A4+B$2 =$A4+C$2 =$A4+D$2 =$A4+E$2 

5 
3 Jan 2020 =$A5+B$2 =$A5+C$2 =$A5+D$2 =$A5+E$2 

6 
25 Jan 2020 =$A6+B$2 =$A6+C$2 =$A6+D$2 =$A6+E$2 

7 
10 March 2020 =$A7+B$2 =$A7+C$2 =$A7+D$2 =$A7+E$2 

Note: 

 ___________________________________________________________________________  

 ___________________________________________________________________________  

 ___________________________________________________________________________  

 ___________________________________________________________________________  

 ___________________________________________________________________________  

 ___________________________________________________________________________  

 ___________________________________________________________________________  

 ___________________________________________________________________________  

 ___________________________________________________________________________  
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 Transpose: Going from rows to columns 
1. If necessary, open the file « Formulas step 1», sheet « Transpose » 

2. Select cells A2 to M12 

3. Click the Copy button on  Home tab Clipboard Group  

 

4. Activate cell A15 to change the row and column headers 

5. From  Home tab  Clipboard Group  Paste  Paste Special  choose  Transpose 
from the "Paste Special" dialog box 

6. Or right mouse button  choose 

  

7. Click OK, here's the result below 
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 Statistical functions 

 

It is possible to manually enter the formula or function without the assistance of the 
tools.  It should be remembered, however, that Excel needs very specific instructions, 
the syntax of the formulas must be respected when it comes to typing them or an error 
is generated. 

EXERCISE Statistical function 

1. Open the file « Formulas step 1 », sheet « Review 1 » 

2. Activate cell B8 to get the average of "Session 1"  

3. Type =AVERAGE, type parenthesis " ( + the cells containing the results of "Session 1" = 

=AVERAGE(B3:B7), the result is "41.25"   

4. If you want to get the "Maximum" grade, you would type "MAX" or for the "Minimum" grade, 

you will type "MIN" 

5. Click OK 

6. Save to close 

 Date function 

 

 Activate the destination cell to insert the date of the day 

 Press the "CTRL" button, then the "semicolon" ";" button. Today's date appears.  

"CTRL +  ; ‘’ 

 

 We want to insert a date that will be updated in future uses of the workbook.  How do I do 
that?  Activate the destination cell, TYPE: The sign = and type TODAY, add an opening and 
closing parenthesis ( ). Confirm with Enter 

 

 

1. Select the cell to be formatted. 

2. Using the pop-up menu obtained by clicking with the right mouse button, click  Format 
Cells  Font tab of the Home tab 

3. Tab  Number, in Category, choose option  Custom. 

4. In the typical area, enter the following code: d mmmm yyyy 
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 SUMIF 

This function allows you to make the sum of a range according to a criterion. This criterion can apply on the 
range you want to add or on another range with the sole condition that the two ranges are the same size. 
Its syntax is SUMIF (range, criteria, [sum_range]) where  

Range represents the range on which the criterion will be applied, it can be the same as sum_range 

 Criterion must be in the form of a number, text or expression of comparison. This criterion 

must be placed in quotation marks and cannot depend on a cell. Example: "<>10" 

(Different from 10) 

 Sum_range is the range on which the sum will be applied.   

The function will cover the range and for each cell X, it will check whether the cell Y, from the same position 

in the range sum_range, actually meets the condition indicated in criterion, if so it adds the value of the X 

cell to the result. Example:   

 

Sum of the set = 176 

SUMIF = Surgery, answer: 89 

FORMULA: =SUMIF(A1:A6;"Surgery";B1:B6) 

 COUNTIF 

This function counts the number of cells corresponding to a criterion in a range. It works much like the 

previous function. Its syntax is COUNTIF(range;criterion)  - range represents the range that will be counted. 

 Criterion must be in the form of a number, a text or an expression of comparison. This criterion 

must be put in quotation marks and cannot depend on a cell. The function runs through each 

cell in the range, if the content of that cell correspond to the condition indicated in the criterion, 

it adds 1 to the result.  
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In the previous table, how many lines contain the word "surgery" 

 

 =COUNTIF(A1:A6;" Surgery") = 3 

 LARGE - SMALL 

This function returns the k-to highest value (or smaller value) of a data series. You can use this feature to 
select a value based on its rank. So you can use the LARGE function VALEUR to return the highest result, 
the second or the third. SMALL to return the smallest result, the second or the third. 

 

In the previous table, what is the largest value in column B 

=LARGE(B:B;1)= 55  ("K1" represent "the greatest value") 

 
In the previous table, what is the smallest value in column B   

=SMALL(B:B;1)= 10 

  

If you like to get the second highest value,  
CHANGE "K" TO READ "2" INSTEAD OF "1" 
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 AVERAGEIF 
The function AVERAGEIF () refers to the average (arithmetic) of all cells that meet several criteria.   

=AVERAGEIF (range;criteria;average range) 

Where:  

Range: is the range of cells you want evaluated  

 

 

 

 

 

 "au*" or "au" or "*au" → all words beginning with 'au', all words ending with 'au', all words 
containing in.  

 A star can replace any character and does not specify the number of characters replaced. 
Au* will find aux and others  

 You can also use a ?, this one will replace only 1 character,  

 Example: au? will find aux, but not others.  
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 Function IF 

Using "IF" to check a condition, then (what should be done?) if not (What to do?)  

=IF(A2>40000 ;A2*5% ;0) or =IF(A2>40000 ;A2*5%";"") 

 If A2 is greather than 40000, then multiply A2 by 5%, if not (in all other cases, 0 or ""  

  

Allows the use of comparison operators: >   <   =   <=   >=   <>   Text must be in quotation marks "   " 

 

If the city is not "Montreal', Yes for "expenses account", if FALSE "No" (to read in the cell) 

=IF(B2<> " Montreal "; "YES "; " NO ")  

 

Note: 

 ___________________________________________________________________________  

 ___________________________________________________________________________  

 ___________________________________________________________________________  
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 Function AND 

Returns TRUE if all arguments are TRUE; FALSE if at least one of the arguments is FALSE. 

This function is usually used nested in another logical function 

Condition: Exam 1 – 2 and 3, note has to be greater or equal to 60: 

Value "TRUE" is "Success", value FALSE is "Failure" 

  

 Function OR 

Returns TRUE if one of the conditions is TRUE and the FALSE if all the conditions are FALSE  

The OR function is usually used nested in another logical function. 

 

Condition: Sale >=30000 

Or Experience >=5 (years) 

Value "TRUE": Commission 10% 

Value FALSE: Commission 5% 
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 Function ISBLANK 

Copying a formula that refers to an empty cell causes a null result to appear or an error message to 

appear. This function is often combined with IF 

The following example results with EMPTY CELL "Column G". To avoid these problems, as in column 

G, the following formula will be used:  

 

 

 Text formulas 

 

To convert text to upper case, here's how to do it:  

1. Open a new file 

2. Type your last name into cell A1 

3. Click in the Formulas tab 

4. Choose: TEXT 

5. Choose: UPPER 

6. In Function Arguments: click in cell A1 
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 LOWER: CONVERT YOUR TEXT TO LOWER CASE 

 TRIM: Delete spaces before and after but not between 

 PROPER: Get the first letter of each word in capital letter:  
example: anna maria for Anna Maria or 
jean-pierre for Jean-Pierre 

 SUBSTITUTE: Replaces existing text with new text, this function will also delete space 

in a cell. Attention: you have to respect the case. 
Example  

 

 

To replace or remove the original cells, you need to copy and then paste the value. 

 

Unite 2 or more columns in a single cell 

Here's how to get your first and last name in one cell:  

 

1. Type your first name in cell A1 and 
your last name in cell B1 

2. In cell C1, click in the Formulas tab 

3. Choose: TEXT 

4. Choose: CONCAT 

5. In Function Arguments CONCAT:  

6. Text 1: Click in cell A1 

7. Text 2: Make your space (keyboard) 

8. Text 3: Click in cell B2 

9. Watch your result 
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1. Type your first name in cell A1 and your last name in cell B1 

2. In A2, type = 

3. Click in cell A1 

4. Type & (located above number 7) 

5. To insert a space between your first and last name, type " " (quotation marks, space, 

quotation marks) 

6. Retype & 

7. Click in cell B1 then enter 

8. Here is the formula and the result: 

 

 

Steps to get one or a few characters in a cell  

1. Type your name in cell A1 

2. Click in the Formulas tab 

3. Choose: TEXT 

4. Choose: LEFT or RIGHT 

 

5. In Function Arguments: Text: Click in cell A1 Num_chars:  Choose the number of 
characters needed 

6. Observe your result which is RIC 
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 Math and Trigonometry 

 

This function is equivalent to ROUNDDOWN (Whole Value) 

1. Type the age in cell A1, someone who was born in 2000 and that his birthday is tomorrow 

2. In cell A2, type the following formula: TODAY() WHICH REPRESENTS TODAYS DATE 
(DYNAMIC DATE) 

3. TODAY() MINUS HIS DATE OF BIRTH, CELL A1, 

4. Put in parenthesis, then divide by 365.25 

5. Your result: 19,99726215, this person will be 20 years old tomorrow only 

6. Click in the Formulas tab 

7. Choose: INT from MATH &TRIG, or tape in front of your formula=INT( then close your 
parenthesis at the end. Do not touch inside of the formula. 

8. Watch your result: THE VALUE IS 19 

9. Tomorrow, your result will be 20  

10. To save a step: in cell A2, type the following formula: 

 

 CONVERTING DATA 

This function allows us to separate the text of a cell into several columns. Or for example, to convert a date 
that is in TEXT format into a DATE format 
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 Convert 

This function allows us to separate the text of a cell into several columns. Or for example, to convert a date 
that is in TEXT format into a DATE format 

 

 

1. Select A1 to A5 

2. From the Data tab 

3. Click in Convert (Text to Columns) 

 

4. Choose Delimited in Step 1 of 3  

 

5. Go to Step 2 out of 3 

6. Choose the comma 

7. View the result in the Data 
preview 

8. Click Finish 
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1. Type a date like this: (DD-MM-YYYY), 25-12-2020 

2. Notice that EXCEL does not recognize this date 

3. Click Convert 

4. Immediately move to Step 3 of 3 

5. Choose: DATE 

6. Choose from the drop-down list the date format we typed: DMY 

7. Click Finish 

 

 NAME MANAGER 

A name is an evocative alias that allows you to immediately know the function of a cell reference, a 

constant, a formula or a table that might otherwise be difficult to guess at first.  

After selecting the range to be named, use  

Formulas tab  Define name 
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OR 

After selecting the range, click on the left portion of the formula bar and enter the name:  

 

OR 

After selecting Create from Selection from the Formulas tab  

 
 To name a cell or cell range:  

 Select a cell or range of cells you want to name.   

 Click in the Name area, to the left of the formula bar.   

 Enter a name that will serve as a reference for the cell. Validate by pressing the Enter button.  

The few rules for using a name: 

 The first character of the name must be a letter, a underline (_) or a dash (-). Afterwards you can 

use letters, numbers, underline or the dot. Your name should not exceed 255 characters.  

 Upper and lower case are not taken into account, in other words, a upper case is equivalent to a 

lower case letter. So, CLINIC is the same as clinic, Excel won't tell the difference between the two.  

 Make sure that the name used does not correspond to a cell. For example, F7 is a cell, so it is 

forbidden to use its name.  

 Finally, the name used may refer to an area (thus a cell range), but it may also have as a scope a 

sheet or a workbook.  
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 in the Formulas tab, in the Defined Names group,  

 

Show names  

 

Once you've set the name of a range, you can easily reach 
the range from the Name Box of the formula bar.  

 

 

Range names are useful for entering a formula. Instead of entering the Address of a range, we can use its 
name. Example: RechercheV 

 

 From the Formulas tab  Name Manager  

 Select the name to be deleted and choose "Delete" from 
the "Name Manager" dialog box 

  
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 Cell protection 
By default, all cells in a sheet are locked. You will find this option in the  Home tab  Group Cells  

Format  Protect Sheet. You also can use right click on the sheet to protect. 

It is important to protect cells in order to avoid mistakenly removing sometimes complex formulas. This is 

done in two steps.  First, you must unlock every cell you want to access, only the cells that have been 

unlocked will be accessible. The second step is to protect the sheet with or without a password. You can 

do this step in  Review tab Protect Sheet. 

 

 

 Determine which cells in the sheet you want to have access to at all times 

 From the   Home Tab  Group Font  Font tab Protection  

 Turn off the "Locked" checkbox 

 To lock or unlock 

 

 

1. From  Review tab Protect Sheet. 

2. Enter a password (you can leave this area empty) 

3. Click OK 

4. Protection can also be found in "Format" of the 
"Cells" group   
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By default, not all formulas in a sheet are hidden. 

Sometimes it is important to protect complex formulas. This is done in two steps. First, you have to hide 
every formula you want to make invisible. You will find this option in Home tab Group Cells Format 
Cells  Protection  

The second step is to protect the sheet with or without a password. You can do this step in the Review Tab 
Protect Sheet. 

 

 Select cells from the sheet containing formulas to make them invisible 

 From  Home Tab Font Group  Protection 

 Check the "Hidden" box 

 

 Click OK 

 

It is important to protect the sheet with a password so that other people can't 

change cells or formatting in your spreadsheet. Also, when you create a password, 

you should always enter it in the same way, respecting upper and lower case. 

 

If you want to change the content of a locked cell or hidden formulas, you should disable the 
protection of the sheet. Select  Review Tab Unprotect Sheet 

 Data validation 

Data validation controls the type of data and values that users enter into a cell. For example, you may want 
to restrict data entry to a certain range of dates, limit the choices available by using a list, or make sure that 
only whole numbers have entered. 

This article describes how data validation works in Excel and presents the different techniques available. It 
does not address cell protection, that is, the feature that allows you to "lock" or hide certain cells in a 
spreadsheet to prevent data from being changed or replaced. 
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Data validation is an Excel feature that sets restrictions on the type and values of data allowed in a cell. You 
can set up data validation to prevent users from entering data that is not valid. If you prefer, you can allow 
users to enter invalid data but notify them when they type it into cells. You also have the ability to display 
messages detailing the type of input expected for cells, as well as instructions to help users correct errors. 

If users ignore this message and type invalid data into the cell, such as a two or five digit number, you can 
display an error message. 

 

Data validation commands are located under the Data tab in 
the Data Tools group. 

Be careful, you have to respect the case  

 

Data validation is particularly useful when sharing a workbook with others in your organization, for which 
you want the data entered to be accurate and consistent. 

You can use data validation to perform, among other things, the following tasks: 

 

   

1. In a new sheet  in Calculation Intermediate workbook, insert the column Payment Type 
into A1. 

2. Select cell A2 or the entire A2:A10 range, then go to the Data Validation box 

3. Select  List  in Validation criteria  Allow 

4. Type in SOURCES:   

5. Interac;Visa;Cash;MasterCard. 

6. Click OK 

7. Watch the drop-down menu in the cell 
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1. Select data (In this example: Cities) 

2. Name your list (In this example: CITY) 

3. In "Date Validation" and then "Sources", type "=" and then the name you gave to the list   

  

 

1. Select cells to insert validation 

2. In "Sources," click on the reference and select the data 

 

In a particular cell, you can specify a minimum or maximum limit 

 

 

You can limit the authorized text in a cell to 10 characters 
or less. Similarly, you can set the specific length of the 
number or text so that it corresponds to the length, 
example: Maximum of 4 characters. 

 

= City  Method 2 
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What users see when they enter invalid data 
into a cell depends on how you set up data 
validation. You can choose to display an input 
message when the user selects the cell. Input 
messages are generally used to offer users 
advice on the type of data that can be entered 
into the cell. You can move this message if 
you wish. It then remains displayed until you 
move to another cell or press Esc. 

  

 

    

 

Icon Type Use to 

 

Stop 
Prevent users from entering invalid data into a cell. A Stop Alert offers two 
options: Retry or Cancel. 

 

Warning 

Warns users that the data entered is not valid, without preventing them from 
entering it. When a Warning message appears, users can click Yes to accept 
the invalid entry, no to change the invalid entry, or Cancel to delete the invalid 
entry. 

 

Information 

Informs users that the data entered is not valid, without preventing them from 
entering it. This type of error message is the most flexible. When an 
Information message appears, users can click OK to accept the value or 
Cancel to opt out. 
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 Error value 

ERROR 
VALUE CAUSE AND SOLUTION 

#VALUE! Error due to invalid name  

This error occurs when the app does not recognize the text contained in a formula.  

 You used a cell name or cell range that does not exist.  

 A name has been misspelled.  

 Text was entered into a formula without being placed in quotation marks.  

 A function has been misspelled.  

#DIV/0 Zero Division Error 

 Entering a formula that makes an explicit 0 division: for example = 5/0  

 Using a reference to an empty cell or a cell containing 0 as a divider. 

#NAME? Error due to invalid name  

This error occurs when the app does not recognize the text contained in a formula.  

 You used a cell name or cell range that does not exist.  

 A name has been misspelled.  

 Text was entered into a formula without being placed in quotation marks.  

 A function has been misspelled.  

#REF! Invalid cell reference error 

This error occurs when a cell's coordinates are not valid.  

 You removed or merged cells that other formulas referred to.  

 You used an invalid cell link.  

#NUM! Number error  

 This error occurs if a formula or function contains invalid numerical values.  

 A number is too large or too small to be represented in Excel. Values must range from 
-1*10307 and 1*10307 

 A function that runs by iteration fails to find a result.  

 You used an incorrect argument in a function that requires a numerical argument.  

#N/A Missing value error 

This error occurs when a value necessary for the formula to function properly is missing.  

 A mandatory argument in the formula is absent.  

 An inappropriate argument is used in a formula.  

 VLOOKUP, HLOOKUP or INDEX functions search an unsorted line or column.  

#NULL! Zero value error  

This error occurs when you specify an intersection of two areas that, in reality, do not 
intersect. The intersection operator is a character of spacing between references.  

Example =SUM(A1 A10). The two points (:) are missing to separate the two cells.  
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It may be interesting to hide some of the planned errors that, however, do not compromise the accuracy 

of the calculations. 

To do this, it is necessary to change Excel's options: Office button  Excel Options  Formulas.  

Error Checking: Uncheck Enable background error checking 

Error checking rules: Select the types of errors Excel must indicate. 

 CIRCULAR REFERENCES 

A formula cannot refer to itself or to another cell whose formula refers to itself. So, if in cell A1 you write 

=A1 or =A2+A3 while the formula in A3 is =A1, Excel warns you of the presence of a circular reference.   

Correct the formula AUDITS AND CHECKS 

 

 

Save your workbook to save the final version of your table, then:  

1. Click the formulas tab  Formula Auditing  Show Formulas.   

2. Check the preview before you print: your table should fit on a single page 

 

1. Go to a cell containing a formula 

2. Click the Formulas tab  Trace Precedents 

 The cells used by the formula will be visualized.  

3. Go to a cell containing a number 

4. Click the Formulas tab  Trace Dependents 

 The formulas that use the cell will be visualized.  
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 Check the preview one last time to use only one sheet of paper  

To remove audit arrows:   

 Click the Formulas tab  Remove Arrows 

 

In a complex Excel file, it may be useful to use the "Watch" window. This feature allows you to observe 

what happens on selected cells in your file when you work in other sections of the file.  

 

Just click and add cells to be monitored when changes are made to other cells affecting this result. There 

is no need to split the screen or use other display modes.  

 
Watch Window equal a link – go to a particular cell. 

Note: 

 ___________________________________________________________________________  

 ___________________________________________________________________________  

 ___________________________________________________________________________  

 ___________________________________________________________________________  

 ___________________________________________________________________________  

 ___________________________________________________________________________  
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 Function VLOOKUP 
Search functions allow you to search for a value in a table, for example: a name, a product number, invoice 
number, phone, address, etc. 

Definition: This feature searches for a value in the first column of a table, which returns the value contained 
on the same row and in another column. 

Dialog box "FUNCTION ARGUMENT"  

VLOOKUP 

Lookup_value Identifies the cell that contains the value that the function looks for in the first 
column of the table 

Table_array Identifies the range (either by an already defined name or by the data 
selection) in which the value search is performed 

Col_index_num Shows which column the value is in. The columns are numbered from the left. 

Range_lookup Enter TRUE if you want the function to return the value closest to the one 
requested "This argument is optional". Enter FALSE if you only want exact 
values. If no value is linked to it, this feature will return #N/A. If you don't 
specify it, EXCEL assumes that the value is TRUE 

 

From the "File" tab, "Options" and "Formulas", check:  R1C1 reference style in "Working with 
formulas" 
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Look for the name of the company for which the customer number is "VS-1255", How to do it? 

1. Open the file "Travel_RechercheV"  

To make it easier, you'll give your data range a name, select the range A1 to J308 from the 
"Customer" sheet   

N_CLIENT (1) Sex (2) Customer (3) D.O.B. (4) Age (5) 

VS-1255 M Claude Patry 2013-04-11 7 

VS-1444 M Peter Schweitzer 2012-02-22 8 

VS-1457 M Pierre-Luc Brisson 2011-08-17 8 

VS-1496 M Tony Gingras 2011-08-26 8 

VS-1212 F Ann Clyde 2009-11-23 10 

VS-1227 M Bernard Pierrot 2009-11-16 10 

VS-1326 M Joël Hanna 2009-11-23 10 

 

2. From the Formulas tab  Define Name type "Customer" in  New Name 

 

3. Return to sheet "Invoice", click in cell B5 to search for the 
customer's name "VS-1255"   

4. Click Lookup & Reference  Formula Tab, choose  
 VLOOKUP 

5. You are now in the "Function Arguments" dialog box  

6. Lookup_value is the "VS-1255" customer number, so 
you need to click cell F5, which represents the desired 
value 

7. Table_array: Enter the name of the table "Customer"  

8. Col_index_num is the column number of the argument 
you're looking for, i.e. that the customer's name is located 
in column Number 2, insert the number "3"     

9. Range_lookup: type FALSE or value 0 
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10. Click OK 

11. Answer: =VLOOKUP(F5;Customer;3;False) 

12. To save time  Lock F5  $F$5 

13. Repeat the same steps to search for the 
address, and contacts. 

14. See the table on the next page for column 
number identification. 

15. In cells A11 and A12, insert DATA 
VALIDATION to choose a city 

16. In cells F11 and F12, VLOOKUP to get the 
amount of the trip 
If the F12 cell is empty, a formula must be 
inserted to eliminate an N/A value when the 
sheet will be protected in writing 

17. Data Validation to create in Cell C16:  
Formulas in cell F17 and F18 

18. Unlock cells to allow data to enter 

19. Protect your sheet and save as 
"Template" 

20. To save as "Template"  File 

 

  

 

False or 0 
0 



FORMATION CAD INC 

A D V A N C E D  E X C E L   P a g e  | 31 

N_CLIENT 
(1) Sex (2) Customer (3) D.O.B. (4) Age (5) Address (6) City (7) 

Province 
(8) P.C. (9) Phone (10) 

VS-1255 M Claude Patry 2013-04-11 7 14 Eloi Montreal Quebec H2C 1R5 (514) 364-7851 

VS-1444  Peter Schweitzer 2012-02-22 8 30 Trent Roxboro Quebec H1N 3L4 (450) 963-2587 

VS-1457 Mr Pierre-Luc Brisson 2011-08-17 8 1271 Macau Laval Quebec H7P 5T6 (450) 454-5258 

VS-1496 M Tony Gingras 2011-08-26 8 20 Avenue De Neuvre Lorraine Quebec J6Z 1W9 (450) 747-7740 

VS-1212 F Ann Clyde 2009-11-23 10 14180 Therrien Mirabel Quebec J7J 1J5 (450) 777-7745 

VS-1227 M Bernard Pierrot 2009-11-16 10 12th Street Montreal Quebec H3P 1R6 (514) 264-7896 

VS-1326 M Joël Hanna 2009-11-23 10 229 Michel Brisset Varennes Quebec J3X 1A3 (450) 456-1256 

VS-1236 F Camillia Elachqar 2008-09-28 11 230 Berri Montreal Quebec H4C 1M2 (514) 289-7458 

VS-1476 M Robert Antoine 2008-09-28 11 2525 Acres Dorval Quebec H4L 4J1 (514) 355-7485 

VS-1497 M Tony Vilek 2009-04-23 10 1230 Nobert Chomedey Quebec G6Y 7J8 (450) 698-5141 

VS-1228 M Bertrand Bolduc 2007-08-16 12 1225 The Abyss Boucherville Quebec J4B 8C6 (450) 245-5567 

VS-1504 M Yves Ferrera 2007-12-21 12 18 De Magog Street Blainville Quebec J7B 1S1 (450) 245-5538 

VS-1380 F Marie-Anne Clyde 2006-09-29 13 1421 Chateaubriant Mascouche Quebec J7K 3B3 (450) 454-5266 

VS-1250 M Christian Bédard 2004-10-03 15 11345 Gilles Villeneuve Mirabel Quebec J7J 1T8 (450) 777-7739 

VS-1443 M Paulo Lemire 2004-10-03 15 293 Gauthier Repentigny Quebec J6A 4P2 (450) 123-7559 

VS-1318 M Jean Paradis 2003-08-23 16 120 St-denis Street Montreal Quebec H5T 4N5 (514) 267-7458 

VS-1201 M Alain Huot 2003-01-24 17 241 Cedars - 3 St. Sophia Quebec J0N 1H0 (450) 999-2026 

VS-1344 F Karine Marder Samuelson 2003-03-05 17 315 Francois-Baillargé Laval Quebec H7L 5:3 (450) 705-3265 

VS-1389 F Maryline Lariviere 2003-01-28 17 1245 12th Avenue Ste-Julie Quebec G4T 5T6 (450) 963-2147 

VS-1246 M Charles Godin 2001-08-14 18 2030 Arthur-Buies Square Montreal Quebec H1L 3G6 (514) 247-1251 

VS-1272 F Denise Nadeau 2000-08-30 19 643 Frontenac Street Lachine Quebec H9V 9G9 (514) 233-4444 

VS-1329 M John Gibis 2000-08-11 19 194 Hogue St. Sophia Quebec J0N 1H0 (450) 999-2025 

VS-1398 M Michel Brown 2000-09-30 19 1280 De La Chanterelle Boisbriand Quebec J7G 2W8 (450) 245-5553 
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 Financial function 
The financial functions can be used to calculate the repayment of a loan, the future value of an 
investment, the amortization of a property, etc. 

 

 Choose "Financial" in the library of the Formulas Tab and select a category and click on 
PMT or NPER or IPMT or PPMT or PV from the "Select Function" area  

 

The amounts payable as well as the refunds are represented by a negative 
number. 

 

FV Returns the future value of an investment 

IPMT Returns the interest payment for an investment  

NPER 
Returns the number of periods for an investment based on periodic, constant 

payments and a constant interest rate  

PER 
Type "1",  this number represents the period for which you want to calculate the 
payment, example: 4 for the fourth month, etc. 

PMT 
Represents the amount of payment per period. This amount is fixed for the duration of 
the loan 

PPMT Represents the monthly capital amount of a loan 

PV Returns the present value of an investment  

RATE Represents the interest rate on the loan 
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LOOK FOR THE NUMBER OF PERIODS TO REPAY A LOAN:  

You borrow the sum of $25,000 at a rate of 8%, however you have $775 per month to repay your loan, 
Looking for the duration of the loan. How do I do that? 

1. Open the file « Formulas step 1 », sheet: Finance 

2. Activate cell F4  

 

3. From the ‘’Formulas’’ tab, click "Financial" and then choose NPER 

4. RATE: Click in cell D4, interest to pay "8%" this value must be divided by 12 (12 months): 
D4/12   

5. PMT: available "$775" to make monthly payments: Cell E4   

6. PV: Type the negative sign "-" then click in cell B4, amount of the loan "$25,000"     

7. Click OK, your answer is 36 

 

8. Here is the formula:  

Note: 

 ____________________________________________________________________________________  

 ____________________________________________________________________________________  

 ____________________________________________________________________________________  
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VALUE OF MONTHLY PAYMENTS 

You borrow $30,000 at an 8% rate, and the term of the loan is 3 years, how do you do it? 

 

1. PMT: represents the value to be repaid per month which is 940 $ Here is the 
formula 

 

 

2. IPMT: represents the interest to be repaid each month. Here is the formula 

 

3. PPMT: represents the capital value that is repaid per month 
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 Pivot Table 

 

The Pivot Table (PT or report) is a multidimensional database analysis tool. It is dynamic because any 
change in the source results in the report being updated when the update is triggered. The PT allows you 
to quickly group, combine and compare a lot of information.  

Each column header in the database becomes a pivot table field. Each next row corresponds to a record.  

The presentation of the summary table is defined by the filter and grouping options, the position of the fields 
and the formulas applied. The PT allows predefined calculations (sum, number, count, average, product, 
numbers, max, min, stdev, stdevp, var, varp). You can also create your own formulas by inserting calculated 
fields and elements.  

The effectiveness of a pivot table is based on a properly structured database.  

Each cell in the first row contains the name of the fields (header).  

 The following rows contain the recordings.  

 The database should not contain two identical field names.  

 Avoid empty cells in fields that store numerical data. 

 The database should not contain empty columns. 

 The database should not contain empty rows. 

 The database should store only raw data (no sub-total rows) 

  

Note: 

 ___________________________________________________________________________  

 ___________________________________________________________________________  

 ___________________________________________________________________________  

 ___________________________________________________________________________  

 ___________________________________________________________________________   
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All the most appropriate commands are in the two context tabs: PivotTable Analyze and Design 

 

 

The pivot table command is very useful when you need to filter multiple fields from the same list (database). 
This command creates a table that calculates values using a synthesis function, such as "Sum", "Average", 
and other... 

At the last step of this assistance, EXCEL creates a table template in which you can drag different fields 
from your list. Excel gives names to fields, here are the names with the definitions: 

 

1. Select a single cell from the database 

2. From the Insert tab Click  Pivot Table  

    

3. Select data to be analyzed as needed 

4. Or use another external data source 

5. Determine where you want Excel to display your pivot table 
 In a new sheet or an existing sheet 

6. Click  OK 

Note: 

 ___________________________________________________________________________  

 ___________________________________________________________________________  

 ___________________________________________________________________________  
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 This field is used to extract data according to the selected item. This field represents the 
Page Field. 

 Now, if more than a filter, we will use the Slicer 

 

 The "Filters" area is used to hide or display subgroups of data in the pivot table.  

 New cells, including an icon, appear in the spreadsheet, just above the PT.  

 Click on the icon to see the window that lists the elements of the filter field.  

 The unchecked items are not taken into account in the report.  

 Each time one or more items are checked in the choice list, the pivot table is updated and 
presents only the corresponding filtered data.  

 A filter icon (funnel-shaped image) is displayed in the PT when elements are filtered.  

 A filter icon also appears on the right of the name, in the "Pivot Table Fields" window. You 
can also filter the field by clicking this button.  

 You can also accumulate and sort multiple fields in the filter area of the report.  

  

1 3 

4 2 
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 The values of this field are arranged horizontally. Every element of this field is displayed on 
a row. 

 

 The values are arranged vertically. Every element of this field is displayed in a column. 

 

 The data in this field is used to make the calculations. 

 Filters Column field 

 

 Row field Data field 

 

The "Field List" button hides and displays the "PivotTable Fields" window. 
The "hidden" setting prevents the window from being automatically displayed 
when a report cell is selected.  

"+/- Buttons" allows you to display or hide the develop/reduce buttons in the 
report. 

The "Field Headers" option hides and displays the field headers of the rows 
and columns. 
  



 

 

 

 
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You can read or change the name of the active field from the input area  

When you select rows or columns labels, the two buttons containing a "greener" and a "less red" button are 
available. The 'Plus' expands all the elements of the active field and the 'Minus' collapses all elements of 
the active field.  

  To hide the details 

  To view more details 

The "Field Settings" button shows the dialog box of the same name, depending on the active cell. 

 

 

 

1. "Sum" returns the sum of all the values of the field. 

2. "Count" returns the number of records in the field. 

3. "Average" returns the average of all the values in this 
field. 

4. "Max" returns the highest value of the field. 

5. "Min" returns the smallest value of the field. 

6. "Product" multiplies all the values of the field. 

7. "Count Numbers" returns the number of digital records 
in the field. 

8. "StdDev" returns the standard deviation of the field. 

9. "StdDevp" returns the standard deviation of a 
population. 

10. "Var" returns the variance of the field. 

11. "Varp" returns the variance of a population.  
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1. "No calculation" uses routine operations. 

2. "% of Row Total" calculates the percentage of 
the row’s total.  

3. "% of Column Total" calculates the percentage 
of the column’s total.  

4. "% of Grand Total" calculates the percentage of 
the overall total.  

5. "Index" calculates relatively ((value in cell) x 
(Grand Total)) / (Grand Total of the line) x (Grand 
Total of the column)).  

6. "Running Total In" calculates a cumulative total 
for the base field.  

7. "Difference from" calculates the percentage 
difference relative to the value of the base item in 
the Base Field.  

8. "% of" calculates the percentage of the value of 
the base item in the Base Field.  

9. "% Difference From" calculates the percentage 
relative to the value of the base item in the Base 
Field.   

 

 

The "Field Settings" window also contains other information and options:  

1. The name of the source field.  

2. The custom name that appears in the report and that is changeable.  

3. The "Number Format" button to customize the values presented in the PT. This will freeze the field 
format even if the data is changed or moved.  

You can accumulate multiple summaries of the same field in the area. Then assign a type of calculation to 
each. This allows you to quickly visualize additional information on the field to be analyzed.  
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The "Sort" group allows you to sort the selection in ascending or decreasing order. If you have any 
doubts about the result (depending on the cell selected), click the "Sort by value" button beforehand. The 
window contains a description of the sorting that will be done. 

We will get this option with the right click mouse button. 

 

 

The "Group selection" button creates a set from the items you select in the report. 

1 When you expand the group, each item value will appear separately. 
When the group is collapsed, the PT displays the total of the constituent 
elements.  

2 The "Ungroup" allows you to delete the selected group. 

3 The "Group field" button allows you to summarize numerical or Date 
elements in the report. For example, select a date in the PT and then click 
the "Group Field" button: Choose the type of grouping (per month).  

      

4 The pivot table then returns the elements grouped according to the chosen element:  

5 You can select multiple group options at the same time. Click the "Ungroup" button to remove groups. 

6 Numerical elements can be grouped in the same way. Example for grouping values by ten:  
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The "Clear" button contains two options that delete the entire pivot table or delete all filters in the report. 

 

The "Select" button allows you to quickly activate certain cells in the report: 

1. Labels and values.  

2. Labels alone.  

3. Values alone.  

4. The entire pivot table. Make sure the "Enable Selection" option is enabled and that the full PT is 
selected to un-grey the menus. 

The "Move Pivot Table" button changes the location of the report to another cell in the workbook or to a 
new sheet. This method keeps your custom cell formatting after moving.  

 

The "Options" button displays the "Pivot Table Options" dialog box. The window 
is made up of 5 tabs.  

 

1. Merge and center the cells with 
labels.  

2. Indent row labels when the report is 
in compact mode (between 0 and 
127 characters).  

3. Sets the display order of the filter 
fields (Down, then over or Over, then 
down).  

4. Assigns value to empty cells. 
Indicate 0 in the numerical fields, to 
make later calculations more 
reliable. 

5. Preserve cells formatting when 
updating data. 
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1. Shows or hides row and column totals 

2. Adds or removes filtered items in sub-totals. 

3. Allows multiple filters per field (to use all values in sub-totals and grand totals, otherwise the calculation 
will not take into account hidden/filtered items). 

 

 

1. Shows or hides expand/collapse 
buttons 

2. Shows or hides the tooltips that 
appear when you move the 
mouse over a value cell in the 
report. The tooltip info returns 
the name of the field, the value, 
as well as the names of row and 
column labels. 

3. The "Classic layout" option 
allows you to drag/drop. 

4. Shows or hides line items that do 
not contain value. 
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1. Prints expand/collapse buttons. It is best to uncheck this option to improve the readability of the print.  

2. The option "Repeat row labels on each printed page". 

3. Set print titles: repeats column headers, rows and column labels for all printed pages. 

 

 

1. The "Save source data with file" option backs up data from the external source with the workbook. 

2. "Enable show details" to extract and view data detail in a new spreadsheet.  

3. Refresh data when opening the file. 
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1. The "Subtotals" button allows you to: not display sub-totals. Show all sub-totals at the bottom of the 
group. Show all sub-totals at the top of the group.  

2. The "Grand Totals" button allows you to: Turn off for lines and columns. Turn on for lines and columns. 
Turn on for lines only. Turn on for columns only.  

3. The "Report Layout" button defines the type of pivot table. Compact form is the default format under 
Excel2007. In Outline form, each row label has its own column. Tabular form displays the data as a 
table.  

4. The "Bland Rows" button inserts or removes a blank line between each group of items. The insertion 
of lines spreads and improves the presentation of the report.  

 

 

The checkboxes define the behavior of the style applied to the PT. Options make it easier to format and 
read the report.  

 

1. Row Headers displays a formatting on the first row of the report.  

2. Column headers display a particular formatting on the first column of the report.  

3. Banded Rows allows different colors to be applied between the even and odd rows of the report.  

4. Banded columns offer different colors to be applied between the even and odd columns of the report. 

 

5. This option allows you to choose a style of presentation from a wide range of predefined formats.  

6.  Click in the lower right corner of the drop-down menu to see the different styles. You can also 
remove a style from the list or add a custom style. A custom style can be defined as the quick style of 
the default pivot table, for the document.  
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It is important to always refresh the data when you're working 

 

Also, make sure the pivot table includes all the new data  

 

 

If the predefined formulas are not enough to summarize the value fields, you have the ability to create 
personal functions tailored to your project. These formulas are called calculated fields and calculated 
elements.  

The calculated fields are based on data from other fields. To create the formula, select the "Analyse" 
tab in the ribbon. Click the "Fields, Items, & Sets" button in the "Calculations" group. Choose the "Calculated 
Field" option. Name your formula in the "Name" zone. It is also in this drop-down menu that you select an 
existing calculated field in order to change or delete it.  

 

Example: To find the total price of wine in "Stock"  per country 

1. Open "Pivot Table"  Workbook  "Wine" sheet 

2. Create a Pivot Table  
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3. Insert "Country" in row label and "In Stock" to "Values" 

4. Choose "Calculated Field" 
 Group Calculations 

5. Name: tape "Total" 

6. Formulas: = in stock * Price 

7. Click OK 

8. See your result 

 

Here's an example: You want a 30% increase in sales for the current year  

1. Open "Pivot Table"  Workbook  
"Boutique" sheet 

2. Create a Pivot Table  

3. Insert "Season" in Row field, "Sales" 
in "Values" and "Year" in columns 
field 

4. To create a "Calculated Item", the 
mouse must be in any year (Columns 
field) 

5. Choose "Calculated Item"  Group 
Calculations 

6. Tape "Forecast 2020 into "Name" 

7. In "Formula," keep the equal, Double-click in the year (Example: 2019) 
and multiply by the desired value. (Example: 30% more than the previous year) so "1.3" 

Formulas: = 2019 * 1,3 

8. Click OK 

9. Here is the result 
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 LIST OF SYMBOLS, CUSTOM FORMAT 

Order Format / cell / numbers / custom category  

Symbol Meaning 

0 
Always displays a number. If there is no number at this location, display a 0. For 

example, code 0.00 always shows two decimal places. 

# Shows a number only if there is one. Doesn’t show anything if there isn't one. 

? Like code 0 but displays a space instead of non-significant zeros. 

, 
The comma serves as a decimal separator. Can be defined as a point in the 

Windows configuration panel. 

% 
Converts the number into a percentage by multiplying by 100 and adding the 

sign. 

$ Shows the currency symbol. 

( ) Shows parentheses. 

Space 
The space is used to separate the thousands. Can be modified for a comma in 

the Windows configuration panel. 

_ 
The underscore leaves a space of 1 character. Can be used to align numbers 

both in the column and on the decimal symbol. 

d/m/yy 

dd-mmm-yyyy 

Date format posted for January 5, 1985 - 5/1/85 

Date format posted for January 5, 1985 - 05-Jan-1985 

dd/mm/yy Date format: posts 01/01/00 for January or 12/12/00 for December. 

mmm Shows the abbreviated names of the month (Jan to Dec). 

mmmm Shows the full name of the month (January to December). 

yy 

yyyy 

Shows the double-digit year 

Shows the four-digit year 

H Shows hours without zero (1 to 23). 

HH Shows hours with zero (01 to 23). 

hh:mm Shows hours and minutes 

[] 
Shows hours above 24 or minutes and seconds above 60. For example, [h]:mm 

gives 72:00 if the cell contains the value 3. 

[color] 
Shows according to the specified color. The available colors are black, blue, 

cyan, green, magenta, red, white or yellow. Example: [red]. 

"text" 
Shows the text specified in quotation marks. For example: # ##0" haba" shows 

1 234 hob if the value 1234 is entered in the cell. 
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 Exercise Condition IF / AND 

This exercise is in the file "Formulas step 2", Sheet:  Ex. 2 Cond.  "AND" 

SCHOOL RESULTS    CONDITION IF / AND 

Student 
Course A 
356 French 

In boarding school 
on the Campus 

RefundPension to CampusSi 
Success at 85% or more 

PARIS, Christine 93 YES REFUND 

PARIS, Corinne 85 NO   

VÉZINA, Andrée 99 YES REFUND 

BEAUDRY, Pierre 68 YES   

BOUCHARD, Stephen 85 YES REFUND 

RICHARD, Alexander 86 NO   

LABONTÉ, Danielle 92 YES REFUND 

LAPIERRE, Marcel 59 NO   

BESSETTE, Benoit 15 YES   

DUVAL, Manon 87 YES REFUND 

 

CONDITION IF / AND IF RESULTS >=85 

AND 
STUDENT IN BOARDING SCHOOL AT CAMPUS, COLUMN C = 
"YES" 

THEN REFUND 

OTHERWISE: NO REFUND "" 

ANSWER =IF(AND(B3>=85;C3="YES");"REFUND";"") 

Note: 

 ___________________________________________________________________________  

 ___________________________________________________________________________  

 ___________________________________________________________________________  

 ___________________________________________________________________________  

 ___________________________________________________________________________  
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 Exercise Condition IF / OR 

This exercise can be found in the file "Formulas step 2", Sheet Ex. 3 Cond." OR" 

SALE OF THE MONTH JANUARY CONDITION IF/OR 

Name 
SALE OF THE 

MONTH  
EXPERIENCE 

(YEAR) 
COMMISSION 

(% ) 
Commission 

($$) 

PARIS, Christine $32,000.00  8 10% $3,200.00  

PARIS, Corinne $35,000.00  3 10% $3,500.00  

VÉZINA, Andrée $25,000.00  6 10%  $2,500.00  

BEAUDRY, Pierre $42,500.00  7 10% $4,250.00  

BOUCHARD, Stephen $22,500.00  1 5% $2,250.00  

RICHARD, Alexander $35,000.00  8 10% $3,500.00  

LABONTÉ, Danielle $24,600.00  12 10% $2,460.00  

LAPIERRE, Marcel $32,500.00  2 10% $3,250.00  

BESSETTE, Benoit $23,000.00  2 5% $2,300.00  

DUVAL, Manon $4,000.00  1 5% $200.00  

 

CONDITION IF/OR ANSWER IN PERCENTAGE  

>=5 =IF(OR(C3>=5 ;B3>=30000);10%;5%) 

OR   

>=30,000 ANSWER IN "$" WITH FORMULA 

COMMISSION OF 10%, IF NOT 5% =IF(OR(C3>5; B3>=30000);B3*10%;B3*5%) 

Note: 
 ___________________________________________________________________________  

 ___________________________________________________________________________  

 ___________________________________________________________________________  

 ___________________________________________________________________________  

 ___________________________________________________________________________  
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 Exercise Pivot Table  

Open the workbook "Pivot Table  

1. Pivot Table: sheet: "Boutique"   

 What is the total sales per season, view the values in $ 

 Add the "Category" field in Column Labels  

Expand columns and make sure you keep the column 
width when updating. 

2. Pivot table: sheet: "Patient"   

 How many patients per age group (Group of 20)? 

 Rename this sheet: "Age group." 

 Add a chart to your Pivot Table (Pie) 

 

3. What is the number of patients per month, per site? 

 Show "Women" only 

 Do you prefer to see "Site" in rows or columns labels? 

 Hide "Filed headers" and adjust all your columns 
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4. Pivot table: sheet: "Patient"   

 What is the number of appointments per SITE, by SPECIALITY with the names of the 
doctors? Here's your result, respect the titles and the graphic presentation 

 Do not forget to change your report layout in "Tabular Form" 

 Hide "Subtotal" from "Specialty" 

 

 


